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Welcome to The Media Streaming Journal

Greetings,

Major  advertising  organizations  and  various  governmental  agencies  continue  to  pressure  online
providers like Youtube and Facebook to “clean up” objectionable content. Youtube took a significant step
at  the  beginning of  this  year  and tightened eligibility  requirements  for  advertising  partnerships  for
content providers.   This  approach may not  be enough in  the eyes of  the giants  of  the advertising
industry.  Unilever is a British-Dutch multinational company specializing in consumer goods that is giving
notice to online social media content providers. The company announced this month that both Google
and Facebook must do a better job at removing offensive and divisive content that can still be found on
their platforms.

Only time will tell as to what else will transpire to appease the market forces that ebb and flow through
the interwebs.

Please feel free to contact either the Publication Director (Derek Bullard) or Chief Editor (myself) if you
have any questions or comments regarding The Media Streaming Journal.

Namaste

David Childers

The Grand Master of Digital Disaster

(Editor In Chief)

www.linkedin.com/pub/david-childers/4/736/72a

Além do mar em um oceano de sonhos.

http://www.linkedin.com/pub/david-childers/4/736/72a
http://www.radiosolution.info/
http://www.radiosolution.info/
http://www.radiosolution.info/
http://publicdomainvectors.org/en/free-clipart/Vintage-microphone-vector-graphics/6111.html
http://publicdomainvectors.org/en/free-clipart/Vintage-microphone-vector-graphics/6111.html


The Media Streaming Journal

What is in this edition of the Media Streaming Journal

Remonetizing Youtube Live
David Childers

What Is Required

Generating Income

Promotional Video

- Create A Promotion Graphic Image

    - Orientating The LibreOffice Document 
      Horizontally

    - Adding A Background Image To The LibreOffice 
      Document

    - Creating The Promotion Graphic Image

    - Save The Finalized Promotion Graphic Image 
      Document

- Convert A Saved PDF File To An Image File Format

    - Export / Convert The PDF File

    - Save The Converted Graphic Image

- Formating The Graphic Image To Have The Proper
  Pixel Size

- Ensure The Graphic Image Has The Proper Pixel 
  Size

    - Scale The Graphic Image

    - Save The Finalized Graphic Image

- Graphic Image Examples

- Create An Audio Sound File

- Combine The Graphic Image With The Audio File 

- Create A Youtube Click Through Button For The 
  Sales Webpage

    - Setup

    - Additional Information

Closing
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http://w  ww.facebook.com/groups/internetradiosupport/
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www.radiosolution.info
Our Mission

Let our friendly, knowledgeable staff assist you to build your project, such as an online radio station
using our high end reliable video and audio streaming technologies. We want to become your partner for
all your hosting needs, as well as your one stop shop for radio products such as custom DJ drops and
radio ID’s.

Start An Internet Radio Station

Whatever you need to start Internet radio station, we will deliver! We provide high quality Internet Radio
services to make your music radio project a success. We can provide Wowza, Icecast, SHOUTcast hosting
and internet  radio services to hobbyists,  deejays,  amateurs  and established professionals.  No radio
station client is too big or too small for Radiosolution.

Choose between complete hassle-free service packages or new features to add to start internet radio
station. Benefit from customized services and the latest in internet radio technology. You will receive
professional, personalized and better Internet Radio Station services than you have received up till now.
If you already have an Icecast or SHOUTcast hosting provider, we can still help you transfer your radio
server over to us with no hassle and at no charge.

Internet Radio Station Services

Launch your internet, digital, satellite or AM/FM radio station anywhere in the world with all of the right
tools. A broadcasting specialist is on standby to help you get started with an SHOUTcast or Icecast
hosting package. We have servers ready for reliable streaming in North America and Europe. Our hosting
packages  have  all  the  features  you  need  to  make  your  radio  station  project  a  success.

If you stream live or with an Auto DJ, we can provide you with the latest in web-based Cloud technology.
You will love the simple to use control panel. Discover how easy it is to manage live deejays, upload
fresh music and create custom scheduled programming.  You will  be able to track your listeners by
getting real time statistics.

Starting your own Internet radio has never been easier. Get in touch with us anytime to start your
Internet radio station.

Radiosolution is a SHOUTcast hosting provider located in Quebec Canada. We also offer Icecast, Wowza
and Web Hosting services. Contact us to discuss the best option available as you start internet radio
station.  Radiosolution  can  provide  personalized  service  in  English,  Dutch,  and  French.  Starting  an
internet radio station can be intimidating, many people want to start one, but have no idea where to
start.  Radiosolution will  be there for you every step of  the way. Everyday people are searching the
internet for free SHOUTcast servers. With Radiosolution SHOUTcast hosting we will allow you to try our
services for FREE. By trying our services, you can be confident that you have chosen the best radio
server hosting provider. You have nothing to loose because we offer a 30 day satisfaction guarantee.
What are you waiting for? Contact us now! Radiosolution offers everything you need to start internet
radio station. You will not need to go anywhere else. We can create your website, market your station
and help you submit your station to online directories. We also feature the voice of Derek Bullard aka
Dibblebee He can create affordable commercials, DJ intros, sweepers, jingles, ids and so much more.

http://www.radiosolution.info/


S.O.S
Sophie is a 22 year old upcoming electro-pop artist who writes, performs and produces her own quirky
material. She has created a distinctive sound for herself which showcases a mixture of husky yet strong,
alternative pop vocals that compliment her rhythmical phrasing and hooky melodies. She thoroughly
enjoys performing live and loves to surprise a crowd by throwing her own spin on popular covers. 

Sophie is looking for stations that want to play music from independent artists and would be pleased to
talk with you about playing her music on your station.

http://www.sosofficial.co.uk

http://www.soundcloud.com/sosofficialuk

http://www.soundcloud.com/sosofficialuk
http://www.sosofficial.co.uk/


Remonetizing Youtube Live
David Childers

Youtube has come under increased pressure and scrutiny over what advertising industry leaders have
labeled as objectionable content. This content has been described as not being suitable for associating
with their advertising brand standards.

Youtube has raised the thresh hold for content providers for participation in their advertising program In
response to this demands.  Many see this recently increased threshold level as a sign of doom. However,
this provides content providers the perfect opportunity to strike out on their own.

One crucial fact that Youtube content creators fail to realize is the fact that the race between online
content  providers  and  advertisement  blocking  software  continues  to  heat  up.   There  are  currently
several  browser  add-ons  that  provide  both  free  and  subscription  models  for  preventing  online
advertising.   These allow people to surf the Internet without being subjected to most forms of online
advertising - I.E., Google Adsense.  

The number of Internet users that purchase or use this advertisement blocking software continues to
increase with many content providers reporting a pronounced drop in revenue being generated from
online advertising.

Other  points  to  consider include the Google Chrome web browser  is  currently  expected to  roll  out
internal  applications that  will  block Internet  advertising,  in addition to Mozilla  deploying internal  ad
blocking applications in its mobile Firefox web browser.

Alternate forms of advertising are available for use by content providers. However, the key to using
these  alternative  forms  of  advertising  is  to  integrate  it  with  the  live  content  seamlessly.   Another
significant  point  is  the  ability  of  the  content  provider  to  have  direct  control  over  the  advertising
inventory that their station uses.

Associating a station with like-minded advertisers or sponsors provides a more branded approach vs.
advertising based on what web cookies have been stored on your computer based on content or pages
that a prospective audience member may have viewed or looked up.



What Is Required

- An industry respected Internet based associate sales or sponsorship program.

- A web page to display the Internet sales items or sponsorship information on.
  (Preferably part of a website that you have direct control over.)

- The ability to produce a promotional video that contains images and audio.

- The promotional video should contain the following elements

- An effective sales pitch to entice the viewing audience to look at the sales or sponsorship program web
page.

- A simple method for allowing the interested audience participants to transition from the broadcast
content to the sales or sponsorship program web page.



Generating Income

Associate Sales

Sales of Items that people associate with a genre, style or aura tend to be more of a personal choice
rather  than an impulse  buy.   This  businesses  arrangement  provides  the  opportunity  to  continue to
attract and retain the ability to achieve successive and individual repetitive sales in the future.

Sales of items through an associative business relationship offer stations with the ability to have access
to a greater variety of sales inventory and opportunities.

It  is  essential  to  seek businesses  that  have a  long-standing  history  of  success  when searching  for
companies that offer and associative sales relationship. Businesses that have a poor performance record
in dealing with clients or customers should be immediately disregarded.

Always diligently research all business that offers clients with the ability to do resale of products or
services. 

Product Sponsorships

A station could consider product sponsorships from items or services, depending on the genre of your
station's  programming.  Several  Internet  businesses  offer  individuals  the  ability  to  promote  their
businesses and receive compensation for any sales that their promotion generates.  Such sponsorships
include website hosting, cloud server hosting, and other non-technical based services.

And  as  before,  always  diligently  research  all  business  that  offers  clients  with  products  or  services
sponsorships.

Donations

A  station  could  also  provide  audience  members  with  the  option  of  doing  a  donation  or  financial
sponsorship. Paypal offers the opportunity of allowing contributions to individuals or businesses that
have accounts with them.



Promotional Video

Creating a unique and compelling promotional video to insert within the broadcast stream will draw the
attention of the audience participants and provide a catalyst for sales or promotions of items.

The promotional video will consist of two unique elements.

These elements include:

- Visual/graphical.

- Audio.

It is essential for each element to reinforce the other and provide a clear, concise and straightforward
message.



Create A Promotion Graphic Image
(For The Graphically Challenged)

A promotional image should be created to be combined with an audio track to create the promotional
video that will be included in the station broadcast stream.

I prefer using LibreOffice as my go to solution for graphic image creation.  The writing application is easy
to use, straightforward and can used with both textual and graphic images. You can use a large variety
of  Font  types  for  creating  artistic  and  professionally  produced  image  graphics.  You  can  also  use
document tables and embedded images as well.

http://www.libreoffice.org/

https://www.libreoffice.org/


Orientating The LibreOffice Document Horizontally

- Open LibreOffice Writer.

- Click on the "Format" tab in the top menu.



- Click on the "Page" tab in the drop down menu.



- Click on the "Page" tab in the top menu – of the Page Style control box.

- Click on the Landscape button under Orientation.

- Click on the Apply button.

- Click on the OK button.



Adding A Background Image To The LibreOffice Document

- Click on the "Format" tab in the top menu.



- Click on the "Page" tab in the drop down menu.



- Click on the "Area" tab in the top menu – of the Page Style control box.

- Set "Fill" to "Bitmap"

- Click on the "Import Graphic" button.

- Select a bitmap graphic image.

- Click on the “Apply” button.

- Click on the “OK” button.



Creating The Promotion Graphic Image

Ensure that all content used for the creation of the promotional image is free from copyright restrictions.

This includes the following content:

- Wording.

- Images.

- Phrases.

The promotional image should contain the following elements:

- A clear message.

- A concise message.

- Easy to understand.

- A unique call to action

- A teaser designed to arouse interest in the audience for visiting the sales web page.



Save The Finalized Promotion Graphic Image Document

- Once the graphic image file has been completed, save the document as a PDF file.

- Click on the "File" tab in the top menu.

- Click on the "Export as PDF" tab in the drop down menu.



- A PDF Options Dialogue box will open.

- Click on the “Export” button.



- An Export dialogue box will open.

- Click on the applicable folder that you want to save the PDF file in – on the Left had side of the dialogue
  box.

- Type the name that you wish to save the PDF file as at the top of the dialogue box.

- Click on the “Save” button at the bottom right of the dialogue box.



Convert A PDF File To An Image File Format

Use the image editing application GIMP to convert the PDF into a easily modified image format.

http://www.gimp.org

- Click on the saved PDF file and open the file with Gimp.

- Click the “Import” button to allow the importation of the PDF file.

https://www.gimp.org/


- Click on the "File" tab in the top menu.



Export / Convert The PDF File

- Click on the "Export As" tab in the drop down menu.



Save The Converted Graphic Image

- An Export dialogue box will open.

- Click on the applicable folder that you want to save the image file in – on the Left had side of the
  dialogue box.

- Type the NAME AND FILE FORMAT that you wish to save the image file as - at the top of the dialogue
  box. ( Save the image file as a JPG or PNG image file format. )

- Click on the “Save” button at the bottom right of the dialogue box.

- Click on the “Export” button at the bottom right of the dialogue box.



Formating The Graphic Image To Have The Proper Pixel Size

Ensure that the size of the of the station card graphical image matches the encoding pixel size of the
broadcast stream.

240p:  426 x 240 

360p:  640 x 360

480p:  854 x 480

720p:  1280 x 720  -  HD

1080p:  1920 x 1080  -  HD 1K

1440p (2k):  2560 x 1440  -  HD 2K



Ensure The Graphic Image Has The Proper Pixel Size

You can use the GIMP graphic editing software to enlarge or shrink the promotion image size If  the
graphic is too large or too small.

- Open GIMP.

- Click on the file and open it with Gimp.

- Click on the "Image" tab in the top menu.

You can check the current graphic image pixel size noted on the top right portion of the software bar.

1280x720 - GIMP



- Click on the "Scale Image" tab in the drop down menu.



Scale The Graphic Image

- Click on the dialogue box next to the image size width and height numbers.

- Ensure that the dialogue box is set to px. (For pixel size.)

- Check the pixel size of the image by reading the numbers in the top left ABOVE THE MENU.

- Adjust the width to match the correct pixel size of the video stream.
  ( The height will automatically adjust to the width to maintain image aspect ratio. )

- When adjusting image size – maintain image clarity.



Save The Finalized Graphic Image

- Save the final graphical image after all editing has been completed.

- Click on the "File" tab in the top menu.

- Click on the "Export As" tab in the drop down menu.



- An Export dialogue box will open.

- Click on the applicable folder that you want to save the PDF file in – on the Left hand side of the
  dialogue box.

- Type the name that you wish to save the PDF file as at the top of the dialogue box.

- Click on the “Save” button at the bottom right of the dialogue box.

- Click on the “Export” button at the bottom right of the dialogue box.



Graphic Image Examples

These are some examples of station promotion images that created using LibreOffice.



Create An Audio Sound File

A sound track should be used to reinforce the message that the graphic image presents.

Ensure that all content used for the creation of the promotional audio is free from copyright restrictions.

This includes the following content:

- Wording.

- Phrases.

- BACKGROUND MUSIC.

The promotional audio should contain the following elements:

- A clear message.

- A concise message.

- Easy to understand message.

- Precise vocal annunciation.

- A unique call to action

- A teaser designed to arouse interest in the audience for visiting the sales web page.

The audio recording should be approximately 30 to 45 seconds in length.

The sound file should be encoded with the following parameters:

-  MP3 Audio Codec

-  Two Channel Stereo Encoding.

-  Variable Bitrate Encoding.

-  48 Khz Sample Rate.

-  256 Kbs Audio Bitrate Encoding.



Combine The Graphic Image With The Audio File 
( Create A Complete Video )

FFmpeg can be used to combine image files with a sound file and create a complete audio/video movie.

Linux static binary build packages:

http://www.johnvansickle.com/ffmpeg/

Windows static binary build packages:

http://ffmpeg.zeranoe.com/builds/

- The image files can be PNG or JPG formated image files.

- The audio file MUST BE encoded using either the MP3 or AAC codec.

ffmpeg -loop 1 -i image-file.jpg -i audio-file.mp3 -shortest -acodec copy -f mp4 video-file.mp4

Script configuration:

Name Of File

Type Of Image File Format  -  (JPG or PNG)

Type Of Audio File Format  -  MP3

Type Of Video File Format  -  MP4

http://ffmpeg.zeranoe.com/builds/
http://www.johnvansickle.com/ffmpeg/


Create A Youtube Click Through Button For The Sales Webpage

  <---------------------------
                                   |

    A click through visual station card 
    can be embedded a station card 
    into the upper left corner of a
    broadcast stream.  
    
     This visual “station” card will  
     contain:
    
     -  A small graphic image.
 
    -  An approved website link.
 
    -  Textual information.

     



Setup

- Go to the Live Stream Dashboard

http://www.youtube.com/live_dashboard

- Click on the Cards tab.

http://www.youtube.com/live_dashboard


- Click on the Create button next to the Link to an approved website tab.



- Enter a properly formatted URL web address that points to the sales webpage.

- Click on the Next button when you have completed this step.



- The associated website dialogue box will open up.
  
   You must input information necessary for your call to action button will work properly.

- The following information is required for input:

  - Card title.

  - Call to action information.

  - Teaser text.

- Select an image to upload – using the “Change Image” button.

- Click on the “Create card” button to enter and save the inputed information.



Additional Information

Call to action

A statement designed to prompt an immediate action by a member of the audience.

- Example

“ Support our station so that we can continue bringing you quality content ”

- The text should be short. concise, and very easy to understand.

Teaser text

A statement designed to arouse interest in the audience for visiting the sales web page.

- Example

“ We offer great benefits to audience members that support our station ”

- The text should be short. concise, and very easy to understand.

Image

The image should represent the content of your broadcast in a graphical format.

“ An image of a piano for classical music. “

“ An image of a Microphone for a talk show. “

“ An image of a cat or dog for a show about pets “

- The image should be easy to understand and visually appealing.

- The image should also be of the highest graphical quality – clear and sharp.



Closing

You can make the transition from depending on the financial quirks of Youtube advertising to creating
your very own economic opportunities.   The essential  requirement is  a well  organized and planned
approach to financial stability.

It  is  essential  to ensure that all  content used in the final form is  free and clear of  any intellectual
property claims by others during the planning, research, and creation process. This will prevent legal
complications from arising in the future.

It  is  essential  to  document  and save all  the  information  required  by the  associate,  sponsorship  or
donation financial service.  It is also highly recommended that source data is kept on the created the
graphic images, audio, and video.

It is vital to track the success rate of encouraging audience participants to visit the sales web page or
donation  page.   Try  running  three  month  test  intervals  to  gauge  the  response  rate  for  updated
multimedia.

It is vital to present a clear, concise and easy to understand message that will easily persuade people
that financially supporting the station or broadcast is important.




